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NĂM HỌC 2019-2020
--------------------

MICROSOFT WORD 2010
Bài 1 – Làm quen với Microsoft Word 2010

1. Khởi động chương trình

Nháy đúp vào biểu tượng chương trình trên màn hình.
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Màn hình chính của chương trình sẽ xuất hiện:
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Các thành phần cơ bản trên màn hình chính gồm:
(1): Thanh công cụ nhanh: Chứa các lệnh thao tác nhanh
(2): File: Chứa lệnh thao tác với tệp
(3): Thanh Ribbon: Chứa gần như toàn bộ các lệnh thao tác với chương trình, chúng được phân chia thành các nhóm khác nhau.
(4): Thanh thước đo: Dùng để đặt Tab, paragraph cho văn bản Cộng 
(5): Thanh cuộn: Dùng để di chuyển văn bản lên xuống, sang trái sang phải
(6): Thanh trạng thái: Chứa một số thông tin hiện thời của văn bản như chế độ hiển thị, phần trăm hiển thị, trang hiện tại,…
(7): Màn hình soạn thảo
2. Tạo một văn bản mới

Khi khởi động chương trình đã tự động tạo sẵn  một văn bản mới.
Cách 1: Nhấp chọn biểu tượng Office Button
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Hộp thoại xuất hiện, chọn New -> Blank Document
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Nháy nút Create.
Cách 2:  Nháy chuột vào mũi tên trỏ xuống trong thanh công cụ nhanh chọn New.
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3. Giới thiệu thanh Ribbon (
Thanh Ribbon là thanh công cụ chứa gần như toàn bộ các lệnh để thao tác với chương trình, như các lệnh về Font chữ về Paragraph, định dạng in ấn,…
Chi tiết các Tab Ribbon
- Home: 
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+ Clipboard: Cắt dán

+ Font: Font chữ
+ Paragraph: Căn lề, phân đoạn
+ Style: Kiểu định dạng
+ Editing: Các chức năng tiện ích khi chỉnh sửa văn bản như tìm kiếm, thay thế, di chuyển,…
- Insert: chứa các nhóm lệnh liên quan đến việc chèn các đối tượng vào văn bản:
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+ Pages: Các lệnh chèn một trang mới vào văn bản hiện thời
+ Tables: Các lệnh liên quan đến bảng
+ Illustrations: Các lệnh chèn đối tượng đồ họa
+ Links: Lệnh chèn các liên kết
+ Header & Footer: Tiêu đề trên và dưới của văn bản
+ Text: Lệnh liên quan đến việc chèn các đối tượng Text như TextBox, Wordart,…
+ Symbols: Lệnh liên quan đến việc chèn các biểu tượng vào văn bản hiện thời.
- Page Layout: chứa các nhóm lệnh liên quan đến bố cục của văn bản.
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+ Themes: Tủy chỉnh nên cho toàn bộ các đối tượng shape trên văn bản.
+ Page Setup: Các lệnh thiết lập định dạng trang in
+ Page Background: Nền cho trang văn bản
+ Paragraph: Các lệnh thao tác với đoạn văn bản
+Arrange: Các lệnh sắp xếp các đối tượng trên văn bản.
- References: chứa các nhóm lệnh liên quan đến một số thủ thuật đặc biệt cho văn bản như đánh mục lục tự động, tạo ghi chú cho văn bản,…
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- Mailings: chứa các nhóm lệnh liên quan đến việc tạo lập một phong bì thư, một mẫu biểu phục vụ cho việc chộn văn bản.
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- Review: chứa các nhóm lệnh liên quan đến các thao tác như kiểm tra ngữ pháp cho văn bản, tạo ghi chú, so sánh nội dung văn bản,…
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- View: chứa các nhóm lệnh hiển thị:
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+ Document Views: Chế độ hiển thị văn bản
+ Show: Tùy chọn hiển thị một số thanh Panel
+ Zoom: Các lệnh phóng to, thu nhỏ văn bản
+ Window: Chứa các lệnh tùy chọn hiển thị nhiều văn bản
+ Macros: Các lệnh về Macros
- Format: Chỉ xuất hiện khi người dùng đang chọn một tối tượng Shape, bao gồm các nhóm lệnh như sau:
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+ Insert shapes: Các lệnh chèn đối tượng Shape
+ Shape styles: Kiểu của các đối tượng Shape
+ WordArt styles: Kiểu của đối tượng WordArt
+ Text: Các lệnh căn chỉnh nội dung Text trong các đối tượng Shape.
+ Arrange: Sắp xếp các đối tượng trên văn bản
+ Size: Các lệnh tùy chỉnh cỡ cho các đối tượng.
4. Thanh trạng thái, thanh cuộn, thanh thước đo
- Thanh trạng thái: Nằm dưới đáy màn hình chính bao gồm các thông tin như chế độ hiển thị, phần trăm hiển thị, tổng số từ, số trang, trang hiện tại,…
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- Thanh cuộn: Dùng để di chuyển màn hình soạn thảo lên trên hoặc xuống dưới, sang trái hoặc sang phải. Thanh cuộn bao gồm 2 thanh là thanh cuộn ngang và thanh cuộn dọc.

- Thanh thước đo: Có chức năng dùng để căn chỉnh vị trí các đối tượng trên văn bản, cũng như căn lề, bố cục cho văn bản. Thanh thước đo cũng bao gồm thành thước ngang và thanh thước dọc
Bài 2 – Soạn thảo văn bản

1. Khái niệm văn bản

Một số thuật ngữ thường dùng
- Character (Ký tự): là tất cả các phím chữ, phím số, phím dấu...
- Word (Từ): Mỗi nhóm ký tự liền nhau và được phân cách bằng khoảng trắng (phím Space Bar) được gọi là một từ. 

- Paragraph: Là một đoạn văn bản được kết thúc bằng cách xuống dòng.
Văn bản thường được gõ Font chữ: Times New Roman,  size 14.

+ Shift-Enter: xuống dòng không tạo Paragraph mới (Line Break)

+ Enter: xuống dòng tạo Paragraph mới (End of Paragraph)

+ Ctrl-Enter: xuống dòng và ngắt sang trang mới (Page Break).

2. Các thao tác với một tệp văn bản
Tạo một văn bản mới

Cách 1: Nhấp chọn biểu tượng New trên thanh công cụ (hoặc nhấn tổ hợp phím Ctrl + N).
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Cách 2: Nhấp chọn biểu tượng Office Button, chọn  New -> Blank Document
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Nháy nút Create.
Lưu lại văn bản

Cách 1: Nhấp chọn biểu tượng Save trên thanh công cụ.

Cách 2: Nhấp chọn nút Save trong cửa sổ Office Button

Nếu văn bản được tạo mới và lưu lần đầu tiên, bằng một trong hai cách trên hộp thoại Save As sẽ xuất hiện như hình dưới đây:
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Chọn đường dẫn lưu File trên ổ đĩa cứng rồi nhập tên cho cho File văn bản vào mục File Name, cuối cùng nhấp nút Save để lưu.
Lưu ý: Để lưu lại văn bản với một tên khác  chọn nút Save As trong cửa sổ Office Button.

Mở một văn bản đã tồn tại

Cách 1: Trong cửa sổ Window Explorer nhấp đúp chuột vào biểu tượng File văn bản cần mở.

Cách 2: Chọn biểu tượng Open (hoặc nhấn tổ hợp phím Ctrl + O).

Cách 3: Từ cửa sổ Office Button nhấp chọn nút Open

Đóng văn bản hiện thời
- Nhấp chọn biểu tượng Office Button

- Hộp thoại Office Button xuất hiện nhấp chọn nút Close

Nếu File văn bản của  chưa lưu chương trình sẽ xuất hiện hộp thoại xác nhận. Nếu lưu lại thay đổi chọn Save, ngược lại chọn Don’t Save.
Thoát khỏi ứng dụng

Cách 1: Nhấp chọn nút Close ở góc trên bên phải. 
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Cách 2: Từ cửa sổ Office Button nhấp chọn nút Exit

3. Soạn thảo văn bản

Gõ chữ tiếng Việt

- â: aa

- ă: aw

- ư: uw

- ơ: ow

- ô: oo

- đ: dd

- ê: ee

- Dấu huyền: f

- Dấu sắc: s

- Dấu nặng: j

- Dấu hỏi: r

- Dấu ngã: x

- Xóa dấu cho chữ hiện thời: z

Di chuyển trên văn bản

- ←: Di chuyển con trỏ chuột sang trái một ký tự so với vị trí hiện thời.

- →: Di chuyển con trỏ chuột sang phải một ký tự so với vị trí hiện thời.

- ↑: Di chuyển con trỏ chuột lên trên một dòng so với vị trí hiện thời.

- ↓: Di chuyển con trỏ chuột xuống dưới một dòng so với vị trí hiện thời.

- Ctrl + ←: Di chuyển con trỏ chuột sang vị trí ký tự đầu tiên của chữ tiếp theo bên trái so với vị trí hiện thời.

- Ctrl + →: Di chuyển con trỏ chuột sang vị trí ký tự đầu tiên của chữ tiếp theo bên phải so với vị trí hiện thời.

- Ctrl + ↑: Di chuyển vị trí con trỏ chuột lên vị trí ký tự đầu tiên của đoạn văn bản bên trên so với vị trí hiện thời.

- Ctrl + ↓: Di chuyển vị trí con trỏ chuột xuống vị trí đầu tiên của đoạn văn bản phía dưới so với vị trí hiện thời.

- Home: Di chuyển con trỏ chuột tới vị trí đầu dòng hiện thời.

- End: Di chuyển con trỏ chuột tới vị trí cuối dòng hiện thời.

- Page Up: Di chuyển con trỏ chuột lên đầu trang hiện thời

- Page Down: Di chuyển con trỏ chuột xuống cuối tran hiện thời

4. Định dạng khổ giấy và đặt lề văn bản
Chọn Tab Page Layout -> Page Setup.
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- Margins: Căn lề cho văn bản.
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- Orientation: 
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Chọn Portrait: dọc khổ giấy
Chọn Lanscape: quay ngang khổ giấy.

- Size: Lựa chọn khổ giấy
Có thể lựa chọn một trong các khổ giấy được liệt kê, thông thường  sử dụng khổ A4 cho các văn bản.

5. Thiết lập Font chữ chung cho văn bản

Chọn Home trên thanh công cụ Ribbon.
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Thông thường chúng ta chọn Font Times New Roman cho văn bản, cỡ chữ 14.
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Bài 3 – Hiệu chỉnh văn bản
1. Lựa chọn văn bản (bôi đen)
Dùng chuột

- Chọn một chữ: Nhấp đúp chuột trái vào chữ cần bôi đen.

- Chọn một phần nội dung văn bản: Di chuyển con trỏ chuột tới vị trí đầu tiên cần bôi đen, giữ chuột trái và rê tới vị trí cuối cùng của đoạn văn bản cần bôi đen.
Dùng bàn phím

- Shift + →: Lựa chọn văn bản bên phải vị trí con trỏ hiện thời.

- Shift + ←: Lựa chọn văn bản bên trái vị trí con trỏ hiện thời.

- Shift + ↑: Lựa chọn phần bên trái của dòng hiện tại và phần bên phải của dòng phía trên so với vị trí con trỏ hiện thời.

- Shift + ↓: Lựa chọn phần bên phải của dòng hiện tại và phần bên trái của dòng phía trên so với vị trí con trỏ hiện thời.

- Ctrl + Shift + →: Chọn phần còn lại bên phải của chữ gần nhất so với vị trí con trỏ hiện thời.

- Ctrl + Shift + ←: Chọn phần còn lại bên trái của chữ gần nhất so với vị trí con trỏ hiện thời.

- Ctrl + Shift + ↓: Chọn phần còn lại bên phải của đoạn văn bản hiện thời tính từ vị trí con trỏ hiện thời.

- Ctrl + Shift + ↑: Chọn phần còn lại bên trái của đoạn văn bản hiện thời tính từ vị trí con trỏ hiện thời.

- Shift + End: Chọn phần còn lại bên phải của dòng diện tại, tính từ vị trí con trỏ hiện thời.

- Shift + Home: Chọn phần còn lại bên trái của dòng diện tại, tính từ vị trí con trỏ hiện thời.

- Ctrl + Shift + End: Lựa chọn nội dung từ vị trí con trỏ hiện thời đến cuối văn bản.

- Ctrl + Shift + Home: Lựa chọn nội dung từ vị trí con trỏ hiện thời đến đầu văn bản.

Sử dụng thanh công cụ Ribbon

Home -> Editing -> chọn Select.
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- Select All: Lựa chọn toàn bộ nội dung văn bản.

- Select Objects: Chỉ cho lựa chọn các đối tượng (hình ảnh, đối tượng shape) có trên văn bản.
- Select Text with Similar Formatting: Lựa chọn nội dung văn bản có định dạng giống như văn bản ở vị trí con trỏ hiện thời.
2. Sao chép, cắt dán, xóa văn bản
Sao chép văn bản
Bước 1: Chọn (bôi đen) nội dung văn bản cần sao chép

Bước 2:  Nhấn tổ hợp phím Ctrl + C hoặc nháy phải chuột chọn Copy

Cắt văn bản

Bước 1: Chọn nội dung văn bản cần cắt (Cut).

Bước 2:  Nhấn tổ hợp phím Ctrl + X hoặc nháy phải chuột chọn Cut

Dán văn bản

Bước 1: Nhấp trỏ chuột tới vị trí cần dán văn bản.

Bước 2: Nhấn tổ hợp phím Ctrl + V hoặc nháy phải chuột trong mục Paste Options 
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 Keep source formatting: Dán cả nội dung Text và dữ lại định dạng như nguyên gốc.
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 Merge formatting: Dán nội dung Text và hòa chộn định dạng gốc với định dạng của vị trí cần dán.
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 Keep Text Only: Chỉ dán mình nội dung Text, lấy định dạng theo định dạng của vị trí con trỏ hiện thời.
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 Chọn biểu tượng Paste: Copy theo mặc định
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 Keep source formatting: Dán cả nội dung Text và dữ lại định dạng như nguyên gốc.
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 Merge formatting: Dán nội dung Text và hòa chộn định dạng gốc với định dạng của vị trí cần dán.

+ [image: image31.png]


 Keep Text Only: Chỉ dán mình nội dung Text, lấy định dạng theo định dạng của vị trí con trỏ hiện thời.

- Nhấp chọn Tab Home trên thanh công cụ Ribbon chọn tới nhóm Clipboard.
Xóa văn bản

- Xoá một ký tự: Đặt con trỏ Text trong văn bản, gõ phím Delete để xoá một ký tự ở bên phải con trỏ Text, gõ phím Backspace để xoá một ký tự ở bên trái con trỏ Text.

- Xoá một đoạn văn bản: Chọn đoạn văn bản mà cần xóa, nhấn phím Delete hoặc phím Backspace để xóa đoạn văn bản đó.

3. Làm việc với đoạn văn bản

Chọn Home trên thanh công cụ Ribbon: 
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- Căn chữ cho đoạn văn bản: Chúng ta sử dụng cách lệnh Alignment để căn chữ cho đoạn văn bản ([image: image33.png]


).
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: Căn chữ theo lề trái của văn bản.
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: Căn giữa chữ cho đoạn văn bản, thường sử dụng cho các tiêu đề.
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: Căn chữ theo lề phải của văn bản 
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: Dàn đều chữ theo khổ giấy của văn bản.
- Căn lề cho cả đoạn văn bản: lệnh Indent để căn lề cho cả đoạn văn bản ([image: image38.png]


).
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: Đưa lề toàn bộ đoạn văn bản sang bên trái một bước Tab (Một lần nhấn phím Tab trên bàn phím).
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: Đưa lề toàn bộ đoạn văn bản sang phải một bước Tab.

Sử dụng hộp thoại Paragraph
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- Alignment: Căn chữ cho đoạn văn bản, nhận 4 giá trị là Left (căn trái), Right (căn phải), Center (căn giữa) và Justified (dàn đều).

- Outline: Dùng để chọn bậc cho đoạn văn bản phục vụ cho việc tạo mục lục tự động.

Sau khi chọn hai giá trị First line và Hanging có thể thay đổi khoảng cách trong mục By.

- Before: Khoảng cách giữa đoạn văn bản hiện thời với đoạn văn bản phí trên nó, thông thường để giá trị là 6 pt.

- After: Khoảng cách giữa đoạn văn bản hiện thời với đoạn văn  phía dưới nó, thông thường để giá trị là 6 pt.

- Line Spacing: Khoảng cách giữa các dòng trong đoạn văn bản, thương chúng ta để giá trị Single.
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+ Single: Khoảng cách là cách giữa các dòng trong Paragraph là 1 dòng.

+ 1.5 lines: Khoảng cách là cách giữa các dòng trong Paragraph là 1.5 dòng

+ Double: Khoảng cách là cách giữa các dòng trong Paragraph là 2 dòng.

+ At Least: Tạo khoảng cách lớn hơn một dòng bằng cách gõ nhập số đo một cách chính xác vào mục At (đơn vị là point).

+ Exactly: Khoảng cách chính xác theo số đã gõ nhập vào mục At (đơn vị là point).

+ Multiple: Khoảng cách tính theo số dòng đã gõ nhập trong mục At (đơn vị là Lines).
4. Định dạng ký hiệu đầu đoạn

- Bullets: Chọn các biểu tượng làm ký hiệu đầu đoạn văn bản, để thực hiện  làm như sau:
Bước 1: Chọn những đoạn văn bản cần thiết kế các ký hiệu đầu đoạn.

Bước 2: Nhấp chuột vào nút Bullets 
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Recently Used Bullets: Biểu tượng sử dụng lần gần nhất và được chọn là biểu tượng mặc định.

Bullet Library: Danh sách các biểu tượng sẵn có

Document Bullets: Biểu tượng đang sử dụng trong đoạn văn bản hiện tại.

Change list level: Thay đổi outsite level cho những đoạn văn bản hiện thời và cùng với nó là thay đổi các biểu tượng đầu đoạn.
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+ Nhấp chọn nút Symbol… nếu muốn thay đổi các biểu tượng
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Sau khi chọn xong biểu tượng mới nhấp Ok để hoàn tất.

+ Nhấp chọn nút Picture nếu muốn sử dụng các hình ảnh làm ký hiệu đầu dòng cho đoạn văn bản.
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- Numbering: Khác với Bullet sử dụng các hình ảnh, biểu tượng làm ký hiệu đầu đoạn văn bản, Numbering sử dụng các ký tự liên tiếp như 1,2,3,… hay I,II,III,… hay a, b, c,… Để sử dụng công cụ này  thực hiện như sau:
Bước 1: Lựa chọn những đoạn văn bản cần tạo ký hiệu đầu đoạn
Bước 2: Nhấp chuột vào nút Numbering 
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+ Trong trường hợp muốn thay đổi  nhấp chuột vào phần mũi tên bên phải của biểu tượng. Một danh sách sẽ đổ xuống như hình dưới đây:
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+ Trong mục Numbering Library  có thể chọn một kiểu bất kỳ để sử dụng làm ký hiệu đầu đoạn văn bản, nếu muốn hủy bỏ chọn mục None.
+ Ok để hoàn tất. 
4. Chia cột cho văn bản
Bước 1: Chọn phần văn bản cần chia cột

Bước 2: Chọn Tab Page Layout, trong Tab này tìm đến nhóm lệnh Page Setup, chọn Columns.
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Bước 3: Trong hộp thoại đổ xuống có thể chọn một kiểu chia cột bất kỳ trong danh sách. Nếu như chưa vừa ý với những mẫu đó hãy nhấp chọn mục More Columns…
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Hộp thoại Column xuất hiện:

- Preset: Kiểu chia cột 

- Number of columns: Số cột cần chia cho nội dung văn bản

- Line Between: Gạch ngăn cách giữa hai cột

- With and spacing: Thay đổi độ rộng và khoảng cách giữa các cột. Trong trường hợp muốn thiết lập độ rộng tất cả các cột bằng nhau  tích chọn mục Equal column width.

- Chọn Ok để hoàn tất.
Bài 4 – Làm việc với bảng biểu
1. Chèn bảng vào văn bản
Bước 1: Đặt con trỏ chuột tại vị trí cần chèn bảng biểu

Bước 2: Từ thanh công cụ Ribbon nhấp chọn Tab Insert và tìm tới nhóm Tables. Chọn biểu tượng Table: 
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- Tạo bảng bằng cách lựa chọn cấu trúc có sẵn: Trong mục Insert Table  di chuyển chuột để chọn cấu trúc bảng màn mình cần tạo, với số hàng, cột là số các ô vuông nhỏ được chọn trong danh sách. 

- Tạo bảng bằng hộp thoại Insert Table:
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+ Number of columns: Số cột của bảng

+ Number of rows: Số hàng trong bảng

+ Fixed column with: Tạo bảng mà độ rộng các cột cố định theo một giá  trị.
+ AutoFit to contents: Tạo bảng mà độ rộng các cột phụ thuộc vào nội dung các cột đó.

+ AutoFit to window: Tạo bảng mà độ rộng các cột dàn đều theo độ rộng của khổ giấy.

+ Remember dimensions…: Lưu lại định nghĩa cấu trúc bảng cho lần tạo tiếp theo.

+ Chọn nút Ok để hoàn tất.
2. Hiệu chỉnh bảng biểu

Lựa chọn (bôi đen) hàng, cột, ô (Cell)
- Lựa chọn một Cell: 
Cách 1: Nhấp chuột chọn tới ô cần lựa chọn trên Table. 
Cách 2: Table -> Select -> Select Cell.
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- Lựa chọn một hàng: 
Cách 1: Di chuyển con trỏ chuột tới vị trí đầu tiên của hàng cần lựa chọn, khi con trỏ chuột đổi thành hình mũi tên màu trắng nhấp chuột trái. 
Cách 2: Table -> Select ->  Select Row.
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Cách 3: Nhấp phải chuột chọn Select -> Row

- Lựa chọn cột: 
Cách 1: Di chuyển chuột tới đỉnh của cột cần lựa chọn, khi con trỏ chuột đổi thành mũi tên trỏ xuống mầu đen,  nhấp chuột trái. 
Cách 2: Table -> Select -> Select Column.
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Cách 3: Nhấp phải chuột chọn Select -> Columns

- Chọn toàn bộ Table:  
Cách 1: Nhấp trái chuột vào biểu tượng phía phải trên của Table.
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Cách 2: Table -> Select -> Select Table.

Thao tác với cột
- Thêm cột
Bước 1: Nhấp chuột tới vị trị cần thêm cột trên bảng.

Bước 2: Thực hiện theo một trong hai cách sau đây:
+ Layout -> Rows & Columns.
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Chọn Insert Left để thêm cột bên trái vị trí con trỏ hiện thời, chọn Insert Right để thêm cột bên phải vị trí con trỏ hiện thời.
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- Xóa cột 

Bước 1: Nhấp chuột chọn tới cột cần xóa trong bảng

Bước 2: Tab Layout -> Rows & Columns -> Delete -> Delete cloumns.
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+ Nhấp phải chuột chọn Delete Cells…
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Hộp thoại Delete Cells xuất hiện tích chọn mục Delete entire column rồi nhấp Ok.
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Thao tác với hàng

- Thêm hàng
Bước 1: Nhấp chuột tới vị trị cần thêm hàng trên bảng.
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Chọn Insert Above để thêm phía trên vị trí con trỏ hiện thời, chọn Insert Below để thêm hàng phía dưới vị trí con trỏ hiện thời.

- Xóa hàng
Bước 1: Nhấp chuột chọn tới hàng cần xóa trong bảng

Bước 2: Rows & Columns ->  Delete ->Delete Rows.
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+ Nhấp phải chuột chọn Delete Cells…
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Hộp thoại Delete Cells xuất hiện tích chọn mục Delete entire row rồi nhấp Ok.
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Thao tác với ô (Cell)

- Thêm ô (Cell): Để thêm một Cell mới vào bảng  chọn tới vị trí cần thêm rồi nhấp phải chuột chọn Insert\Insert Cells…
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- Xóa ô (Cell):  Nhấp phải chuột chọn Delete Cells…
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Hộp thoại Delete Cells xuất hiện như hình dưới đây:
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Chọn Shift cells left để xóa Cell bên trái vị trí con trỏ hiện thời, chọn Shift cells up để xóa Cell phía trên vị trí con trỏ hiện thời, cuối cùng nhấp Ok để thực hiện.

- Gộp Ô (Cell) 
+ Chọn nhóm Cell cần gộp

+ Nhấp phải chuột chọn Merge Cells.
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Hoặc chọn Merger chọn nút Merger Cells.
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- Tách Cell: 
+ Chọn nhóm Cell cần tách

+ Merge -> Split Cells.
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Xuất hiện hộp thoại: chọn số hàng, số cột -> OK
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3. Nhập nội dung và trình bày bảng biểu

Nhập và trình bày nội dung

- Nhập dữ liệu: Muốn nhập dữ liệu cho Cell nào  di chuyển con trỏ tới Cell đó và nhập nội dung cho Cell, sử dụng các mũi tên để di chuyển con trỏ chuột giữa các Cell. Sau khi nhập nội dung cho Table  có thể tùy biến Font chữ cho nội dung tương tự như thao tác với nội dung văn bản.

- Căn chỉnh độ rộng, chiều cao của Cell
Bước 1: Chọn Cell hoặc nhóm Cell cần căn chỉnh độ rộng, chiều cao.
Bước 2: Cell size.
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Để thay đổi độ rộng hay chiều cao cho Cell  nhập thẳng giá trị vào hai ô nhập Table Column With và Table Row height.
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 Table Column With: Thay đổi độ rộng
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 Table Row Height: Thay đổi chiều cao

- Căn chỉnh vị trí nội dung trong Cell:
 Bước 1: Chọn Cell hoặc nhóm Cell cần căn lề nội dung

Bước 2: Layout  ->  Alignment.
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 Align Top Left: Căn nội dung theo lề trên bên trái của Cell.
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 Align Top Center: Căn nội dung theo lề trên và căn giữa Cell.
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 Align Top Right: Căn nội dung theo lề trên bên phải của Cell.
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 Align Center Left: Căn nội vào giữa bên trái của Cell
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 Align Center: Căn nội dung chính giữa Cell
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 Align Center Right: Căn nội dung vào giữa bên phải của Cell.
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 Align Bottom Left: Căn nội dung dưới đáy bên trái của Cell.
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 Align Bottom Center: Căn nội dung vào giữa dưới đáy của Cell.
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 Align Bottom Right: Căn nội dung dưới đáy bên phải của Cell.
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 Text Direction: Đổi chiều chữ trong Cell, giả sử nội dung quá dài các Cell không chứa hết  có thể quay đứng chữ để tiết kiệm diện tích. Cách này thường sử dụng cho tiêu đề cột.
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 Cell Margins: Căn lề cho nội dung trong Cell.
+ Default cell margins: Đặt lề cho Cell bằng cách nhấp giá trị cho các mục Top, Bottom, Left, Right.

+ Default cell spaceing: Tích chọn mục này để thiết lập khoảng cách giữa các Cell.

+ Options: Tích chọn mục này để tự động điều chỉnh cỡ Cell theo nội dung.
Trình bày bảng biểu

- Nhóm Table Styles: Dùng để thiết lập Style cho bảng biểu.
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+ Header Row:  chọn để áp dụng kiểu Style tiêu đề cho dòng tiêu đề. 

+ First Column: chọn  để áp dụng Style cho cột tiêu đề.
+ Total Row: chọn để áp dụng Style cho cột tổng cộng.
+ Last Column: chọn  để áp dụng Style cho cột cuối cùng.

+ Banded Rows: chọn để áp dụng Style cho các hàng trong bảng.

+ Banded Columns: chọn để áp dụng Style cho các cột trong bảng.

+ Chỉnh sửa một Style sẵn có: Từ danh sách Style nhấp chọn Modify Table Style…

- Thay đổi màu nền cho bảng biểu: 
Bước 1: Nhấp chọn nhóm Cell cần thay đổi màu nền

Bước 2:  Design -> Shading
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Hoặc  Border -> Border and Shading…

[image: image90.png]Bottom Border

Top Border orders.

Left Border
R

ht Border

No Border
AllBorders
Outside Borders

+H8

Inside Borders

Inside Horizontal Border
Inside Vertical Border

Diagonal Down Border

Ns

Diagonal Up Border

Horizontal Line

o

Draw Table.

View Gridiines





Trong mục Fill  chọn mầu nền cho Cell hoặc nhóm Cell hiệnthời.

+ Thiết lập Border cho bảng:  có thể thay đổi mầu sắc, nét vẽ cho các đường Border của bảng:
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Có thể chọn một kiểu Border thích hợp trong danh sách, nếu muốn có thêm các lựa chọn và tùy chỉnh hãy nhấp chọn mục Borders and Shading…
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Setting: Chọn kiểu Border

Style: Kiểu đường kẻ

Color: Mầu cho đường kẻ

Width: Độ rộng của đường kẻ
Lưu ý: Trong mục Preview  có thể nhấp chuột để áp dụng hay hủy bỏ Border giống như trên hình ảnh minh họa.
Bài 5 – Chèn các đối tượng vào văn bản
1. Chèn một trang mới

Insert -> Pages và Header & Footer
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- Cover Page: Thêm một trang mới vào văn bản với mẫu dựng sẵn. 
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Hãy nhấp chuột chọn tới trang mẫu cần chèn vào văn bản.

- Blank Page: Chèn một trang trắng vào văn bản hiện thời

- Page Break: Ngắt sang một trang mới và không mang theo thuộc tính, định dạng của trang cũ.

- Header và Footer: Tiêu đề trên và dưới của văn bản.

+ Nhóm Header & Footer
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Header: Lựa chọn danh sách mẫu Header

Footer: Lựa chọn danh sách mẫu Footer

Page Number: Chèn số trang vào văn bản, khi nhấp chọn biểu tượng này một danh sách liệt kê xuất hiện như hình dưới đây:
[image: image96.png]Page Margins
Current position
Eormat Page Numbers.

Remove Page Numbers




có thể tùy chọn chèn số trang lên trên đỉnh hoặc dưới đáy của trang, ngoài ra  cũng có thể chỉnh sửa định dạng của số trang văn bản bằng cách nhấp chọn Format Page Numbers…

+ Nhóm lệnh Insert: Cho phép chèn thêm các tham số vào Header hoặc Footer.
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Date & Time: Thông tin về ngày tháng hiện thời.
Quick Parts: Chèn các trường, các thuộc tính của văn bản.
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Picture: Chèn thêm các hình ảnh.
Clip Art Pane: Chèn thêm các Clip Art

+ Nhóm Navigation: Cho phép tạo nhiều định dạng Header và Footer trong cùng một văn bản. 
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Goto Header: Di chuyển con trỏ chuột tới Header

Goto Footer: Di chuyển con trỏ chuột tới Footer

Previous Section: Chuyển về vùng Header, Footer trước

Next Section: Chuyển tới vùng Header, Footer tiếp theo

+ Nhóm lệnh Options
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Different First Page: tạo Header, Footer riêng cho trang đầu tiên trong văn bản.
Different Odd & Even Pages: tạo Header, Footer cho trang chẵn, lẻ khác nhau.

Show Document Text: hiển thị nội dung văn bản khi đang chỉnh sửa Header, Footer. Nếu không tích chọn mục này toàn bộ nội dung văn bản sẽ ẩn đi.

+ Nhóm lệnh Position: Chứa các lệnh thiết lập độ rộng của Header, Footer.
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Header from Top: Khoảng cách từ Header xuống tới nội dung văn bản.

Footer from Bottom: Khoảng cách từ Footer lên tới nội dung văn bản.

+ Nhóm lệnh Close: Thoát khỏi chế độ chỉnh sửa Header, Footer.
2. Chèn hình ảnh

2.1. Chèn File ảnh trên ổ đĩa

Bước 1: Nhấp trỏ chuột tại vị trí cần chèn File ảnh vào văn bản.

Bước 2: Insert chọn Picture.
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Cửa sổ Insert Picture xuất hiện  tìm tới File ảnh cần chèn vào văn bản, nhấp chọn File này rồi nhấn nút Insert.

[image: image103.png]Insert Picture.





Hình ảnh vừa chọn sẽ được chèn vào văn bản tại vị trí đã chọn.

Bước 3: Tùy chỉnh hình ảnh trên văn bản:
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- Nhóm lệnh Adjust: 
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+ Color: 
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More Variations:  có thể thay tông mầu cho hình ảnh.

Set Transparent Color: Hòa lẫn mầu nền với mầu nền văn bản.

+ [image: image107.png]5 Change Picture



 Change Picture: Thay thế hình ảnh hiện tại.
- Nhóm lệnh Picture Styles
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+ Danh sách các Style: 
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+ [image: image110.png]


 Picture Border: chọn mầu thích hợp cho đường viền của ảnh.
[image: image111.png]L.
‘Theme colors
N EEEEEEN

Standard Colors

NN EEEEEE
Dutine

@ More Outline Colors.

weight »

Dashes >





+ [image: image112.png]


 Picture Effect:  có thể thay đổi bóng, các góc nghiêng cho ảnh,…
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+ [image: image114.png]® Picture Layout ~



 Picture Layout: điền thêm các ghi chú minh họa cho hình ảnh, ... 

- Nhóm lệnh Arrange:  sắp xếp vị trí hình ảnh trên văn bản.
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+ Position: thiết lập vị trí cho hình ảnh trên trang văn bản.
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+ Wrap Text: 
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+ [image: image118.png]L Bring Forward



 Bring Forward: Hiển thị hình ảnh lên trước các hình ảnh khác.

+ [image: image119.png]4 Send Backward ~



 Send Backward: Hiển thị hình ảnh sau các hình ảnh khác.
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 Align: căn chỉnh lề cho một hoặc nhiều hình ảnh một lúc.
+ [image: image121.png]


 Group: để nhóm chúng lại thành một thể thống nhất. 

Trường hợp muốn gỡ nhóm  nhấp chọn Ungroup.
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 Rotate: Xoay chiều hình ảnh.
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- Nhóm lệnh Size: Dùng để thay đổi kích thước của ảnh trên văn bản.

+ [image: image124.png]


 Crop: Điều chỉnh phạm vi hiển thị của ảnh.
2.2. Chèn Clip Art 

Insert -> Clip Art.
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- Organize clips…: Các Clips sẵn có trong chương trình

- Clip art on Office Online: Các Clip tải thêm từ Internet.
2.3. Chèn đối tượng Shapes

Insert -> Shapes
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Một danh sách các đối tượng Shape được liệt kê như hình dưới đây:
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- Nhóm lệnh Insert Shape
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+ [image: image129.png]


 Edit Shape: Cho phép thay đổi hình dạng của đối tượng Shape. 

+ [image: image130.png]


 Shape Fill: Thay đổi mầu nền cho các đối tượng Shape. 

+ [image: image131.png] Shape Outline



 Shape Outline: Thay đổi màu viền cho đối tượng Shape.

+ [image: image132.png]Shape Effects



 Shape Effects: tùy chỉnh các ứng dụng hình ảnh cho các đối tượng Shape.

- Nhóm lệnh Text: thao tác với nội dung Text trong các đối tượng Shape.
+ Align Text: Căn chỉnh vị trí nội dung Text trong đối tượng Shape.
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 Top: nội dung Text được căn lên đỉnh các đối tượng Shape
Middle: nội dung Text được căn giữa các đối tượng Shape
Bottom:Nội dung Text được căn dưới đáy các đối tượng Shape.
- Nhóm lệnh Arrange: sắp xếp vị trí đối tượng Shape trên văn bản.
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Position: thiết lập vị trí cho đối tượng Shape trên trang văn bản.
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Wrap Text:
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 Bring Forward: Hiển thị đối tượng Shape lên trước các đối tượng khác.
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 Send Backward: Hiển thị đối tượng Shape sau các hình ảnh khác.
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 Align: căn chỉnh lề cho một hoặc nhiều đối tượng Shape một lúc. 
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Nhấp chuột để chọn kiểu cần thiết lập.
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 Group: Gộp nhóm các hình thành một thể thống nhất. [image: image141.png]



Trường hợp muốn gỡ nhóm  nhấp chọn Ungroup.

· Rotate: Xoay chiều đối tượng Shape
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- Nhóm lệnh Size: Dùng để thay đổi kích thước của đối tượng Shape trên văn bản.

+ [image: image143.png]


 Shape height: Thiết lập chiều cao cho đối tượng Shape.

+ [image: image144.png]


 Shape width: Thiết lập độ rộng cho đối tượng Shape.

2.4. Chèn đối tượng SmartArt

Đối tượng SmartArt là một thư viện các sơ đồ theo nhiều chủ đề kiểu dáng khác nhau.  
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Hộp thoại Choose a SmartArt Graphic xuất hiện như hình dưới đây:
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2.5. Vẽ biểu đồ

Chèn biểu đồ vào văn bản
Insert ->  Chart
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Hộp thoại Change Chart Type xuất hiện như hình dưới đây:
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 chọn một mẫu biểu đồ nhất định trong danh sách sau đó nhấp Ok. 
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Trong cửa sổ Excel chứa dữ liệu nguồn tạo biểu đồ,  có thể thay đổi dữ liệu cho phù hợp với biểu đồ mình cần vẽ sau đó đóng cửa sổ Microsoft Excel lại. Như vậy một biểu đồ đã được chèn vào văn bản.
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Tùy chỉnh thiết kế cho biểu đồ
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- Type
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+ Change Chart Type: Mở lại hộp thoại Change Chart Type mà không cần quay lại Tab lệnh Insert.

+ Save As Template: Lưu kiểu Chart hiện thời thanh mẫu để có thể dùng lại các lần sau.
- Data
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+ Edit Data: Mở bảng dữ liệu nguồn của biểu đồ ở dạng File Excel

+ Select Data: Lựa chọn lại dữ liệu nguồn cho biểu đồ, khi nhấp chọn nút lệnh này cửa sổ Excel sẽ xuất hiện như hình dưới đây:
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 nhấp chọn nút lệnh Edit để thay đổi vùng dữ liệu cho biểu đồ sau đó nhấp Ok để lưu lại.

+ Switch Row/Column: Chuyển đổi dữ liệu giữa hàng – cột và ngược lại (nút lệnh này chỉ sáng khi mở bảng dữ liệu nguồn Excel)

+ Refresh Data: Làm mới lại dữ liệu nguồn sau khi chỉnh sửa.

- Chart Layouts: Dùng để thay đổi cấu trúc của biểu đồ theo những mẫu mô tả trong khung này.
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Để mở rộng danh sách các Chart Layouts  nhấp chọn mũi tên dưới cùng bên phải.
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- Chart Styles: Thay đổi Style cho biểu đồ với cấu trúc đã chọn
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Tùy chỉnh Layout cho biểu đồ

Layout
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- Current Selection
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+ [image: image160.png]


 Chart elements: Lựa chọn các thành phần trên biểu đồ. 

Chart Area: Vùng chứa toàn bộ biểu đồ

Chart Title: Tiêu đề biểu đồ
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Horizontal (…) Axis: Chỉ tiêu trục ngang của biểu đồ

[image: image162.png]Chart Title





Legend: Ghi chú chỉ tiêu
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Plot Area: Vùng chứa chỉ tiêu trên biểu đồ

[image: image164.png]Chart Title





Series “…”: Một chỉ tiêu cụ thể
[image: image165.png]Chart Title





Chart Title:  thay đổi thuộc tính đường viền, căn chỉnh vị trí của tiêu đề trên Char Area.
Horizontal (…) Axis: định dạng nội dung chỉ tiêu trục ngang như căn chỉnh nội dung, mầu sắc đường viền,…

Legend: thay đổi vị trí của Legend trên Char Area, kiểu dáng, mầu sắc của đường viền,…

Plot Area: thay đổi mầu sắc, hình ảnh nền, thiết lập thuộc tính cho đường viền, bóng,…

- Insert: chèn thêm các đối tượng khác vào biểu đồ
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- Labels: Cho phép tùy chỉnh các nhãn (Label) có trên biểu đồ
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+ Chart Title: Nhãn tiêu đề của biểu đồ
+ Axis Title: Tiêu đề trục (ngang – dọc), nhấp chọn nút lệnh này  có thể lựa chọn thêm tiêu đề cho trục ngang hoặc dọc

- Axes: Thiết lập trục cho biểu đồ (Không sử dụng cho các biểu đồ hình quạt)
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+ Axes: Nhấp chọn biểu tượng này  có thể thiết lập thuộc tính trục ngang và trục dọc của biểu đồ.

- Backgroud: Thiết lập các thay đổi cho nền của biểu đồ
3. Chèn các đối tượng Text
3.1. Text Box

Là một khung chứa văn bản, ngoài việc thay đổi nội dụng bên trong  còn có thể tùy chỉnh thiết kế mầu sắc, nền cho các TextBox. 
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3.2. Chèn đối tượng WordArt 

WordArt là đối tượng chữ hiệu ứng được sử dụng khi muốn trình nội dung dưới dạng chữ nghệ thuật.
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Nhập nội dung cho WordArt

Hiệu chỉnh WordArt
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- Quick Styles: Thay đổi kiểu chữ nghệ thuật mà không phải trở về Tab Insert

- Text Fill: Hiệu chỉnh mầu cho thân chữ
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4. Biểu tượng và công thức toán học

4.1. Chèn biểu tượng

 Chọn Symbol
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Chọn mục More Symbols… để có thêm sự lựa chọn. 
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4.2. Chèn công thức toán học
Chọn Equation 
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Tùy chỉnh
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- Nhóm lệnh Tools:

+ Equation: Chọn mẫu Equation mà không cần trở lại Tab Insert

+ Profesional: Thể hiển công thức dưới dạng chuẩn

[image: image179.png]eer=e] )




+ Linear: Viết dưới dạng các ký tự đơn giản
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- Nhóm lệnh Symbols
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- Nhóm lệnh Structures: 
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+ Large Operator
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+ Bracket
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+ Function: Công thức về các hàm toán học
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+ Accent
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+ Limit and Log: Công thức về giới hạn (Lim) và logarit
[image: image187.png]loge:

o
2%
m(ué)





+ Operator
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+ Martrix: Công thức về ma trận
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Bài 6 – In ấn
1. Định dạng văn bản trước khi in

Thiết lập trang in
Trước khi in ấn  nên kiểm tra lại các thông số về khổ giấy, căn lề của văn bản. 
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Hộp thoại Page Setup xuất hiện như hình dưới đây:
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Trong hộp thoại này ở hai tab Margins và Pager sẽ cho phép  thiết lập các thông số như lề văn bản, khổ giấy, chiều của khổ giấy.

Lưu ý: Với trường hợp in hai mặt chúng ta xử lý như sau: Chọn Mirror margins trong mục Multiple pages của Tab Margins.
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2. Thực hiện in ấn

Cách 1: Nhấn biểu tượng Print
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Cách 2: Nhấp tổ hợp phím Ctrl + P 
Trong hộp thoại Print:
+ All: In toàn bộ văn bản, cũng tương ứng  không thiết lập gì cho mục này. Mặc định máy in sẽ in tất cả các trang của văn bản.

+ Selection: Chỉ in vùng được chọn

+ Current Page: Chỉ in trang hiện tại (Trang con trỏ chuột đang đứng)

+ Print Odd Pages Only: Tích chọn mục này để chỉ in trang lẻ

+ Print Even Pages only: Tích chọn mục này để chỉ in trang chẵn

- Other Settings: Các tùy chọn khác khi in ấn

+ Collated: Nếu in copy thành nhiều bản,  có thể chọn in lần lượt từng bộ một hay in tất cả các bản của từng trang.

+ Portrait Orientation: In theo khổ giấy ngang hay dọc.

+ Last custom margin settings: Chọn lề cho trang in

+ Page Per Sheet: In nhiều trang trong một tờ giấy

+ Nháy nút Print để thực hiện in văn bản
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